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8.2.1.4029.1.523496.503679

		REPORTING DEPARTMENT OR AGENCY: US Army Installation Management Command

		EVENT DATES:: 8/19-30/2018

		BENEFITS ACCEPTED. AMOUNT: 1063.00000000

		TRAVELER NAME. CONTINUED FROM FIRST PAGE. SECTION 6 OF 10: SSG Spenser Mango

		TRAVELER TITLE: Soldier AthleteArmy World Class Athlete Program

		EVENT DESCRIPTION: Grand Prix of Germany and German National Training Camp

		LOCATION: Dortmund &Saarbruken, Germany

		TRAVEL DATES: 8/16-25/2018

		BENEFITS ACCEPTED. SOURCE: USA Wrestling

		BENEFITS ACCEPTED. DESCRIPTION. LINE 3 OF 4: Air Transportation

		BENEFITS ACCEPTED. CHECK: 

		BENEFITS ACCEPTED. IN-KIND: X

		EVENT SPONSOR: USA Wrestling
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		REPORTING DEPARTMENT OR AGENCY: US Army Installation Management Command

		EVENT DATES:: 9/20-25/2018

		BENEFITS ACCEPTED. AMOUNT: 500.00000000

		TRAVELER NAME. CONTINUED FROM FIRST PAGE. SECTION 6 OF 10: PFC Ashlee Byrge

		TRAVELER TITLE: Soldier AthleteArmy World Class Athlete Program

		EVENT DESCRIPTION: Governor's Cup Rugby Tournament

		LOCATION: Jozankei Sapporo,Japan

		TRAVEL DATES: 9/20-25/2018

		BENEFITS ACCEPTED. SOURCE: USA Rugby

		BENEFITS ACCEPTED. DESCRIPTION. LINE 3 OF 4: Air Transportation

		BENEFITS ACCEPTED. CHECK: X

		BENEFITS ACCEPTED. IN-KIND: X

		EVENT SPONSOR: USA Rugby
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		REPORTING DEPARTMENT OR AGENCY: US Army Installation Management Command

		EVENT DATES:: 8/20/2018

		BENEFITS ACCEPTED. AMOUNT: 863.00000000

		TRAVELER NAME. CONTINUED FROM FIRST PAGE. SECTION 6 OF 10: Dorothy Brown

		TRAVELER TITLE: IMCOM Chief, Child DevelopmentProgram

		EVENT DESCRIPTION: Harvard Business School Leadership Summit

		LOCATION: Boston, MA

		TRAVEL DATES: 6/17-21/2018

		BENEFITS ACCEPTED. SOURCE: BGCA

		BENEFITS ACCEPTED. DESCRIPTION. LINE 3 OF 4: Meals

		BENEFITS ACCEPTED. CHECK: X

		BENEFITS ACCEPTED. IN-KIND: X

		EVENT SPONSOR: Boys & Girls Clubs of America(BGCA)
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		REPORTING DEPARTMENT OR AGENCY: U.S ARMY INTELLIGENCE AND SECURITY COMMAND

		REPORTING PERIOD. OCTOBER 1- MARCH 31 (YEAR): 

		REPORTING PERIOD. APRIL - SEPTEMBER 30 (YEAR): 2018

		PAGE: 1

		OF PAGES: 1

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 600.00000000

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 1

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: Hotel 

		BENEFITS ACCEPTED SOURCE: Training Camp (NFE who sponsors and conducts this type of training) 

		TRAVEL DATES. : 23  - 27 April 2018

		LOCATION: Vienna, VA

		EVENT DATES. : 23 - 27 April 2018

		EVENT SPONSOR : Training Camp

		EVENT DESCRIPTION: ISACA CISM Certification Boot Camp Training Course

		TRAVELER (TITLE).  Line 1 of 4.: Brigade Chief Information Officer

		TRAVELER (NAME).  Line 1 of 4.: Matthew Teltoe

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 1372.00000000

		BENEFITS ACCEPTED AMOUNT: 3686.00000000

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 1

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 1

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: Meals

		BENEFITS ACCEPTED DESCRIPTION: Lodging

		BENEFITS ACCEPTED SOURCE: Royal Netherlands Army using NATO funds

		TRAVEL DATES. : 6 - 28 June 18

		LOCATION: t'Harde Netherlands

		EVENT DATES. : 6 - 28 June 2018

		EVENT SPONSOR : NATO

		EVENT DESCRIPTION: NATO Experiment Unified Vision 2018

		TRAVELER (TITLE). Line 2 of 4.: Analyst

		TRAVELER (NAME). Line 2 of 4.: Randall Vann

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 294.00000000

		BENEFITS ACCEPTED AMOUNT: 582.00000000

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 1

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 1

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: Meals

		BENEFITS ACCEPTED DESCRIPTION: Lodging

		TRAVEL DATES. : 26 - 28 June 18

		LOCATION: t'Harde Netherlands

		EVENT DATES.: 26 - 28 June 2018

		EVENT SPONSOR : NATO

		EVENT DESCRIPTION: NATO Experiment Unified Vision2018

		TRAVELER (TITLE). Line 3 of 4.: Analyst 

		TRAVELER (NAME). Line 3 of 4.: Robert Cecchini

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED SOURCE: 

		TRAVEL DATES. : 

		LOCATION: 

		EVENT DATES. : 

		EVENT SPONSOR : 

		EVENT DESCRIPTION: 

		TRAVELER (TITLE). Line 4 of 4.: 

		TRAVELER (NAME). Line 4 of 4.: 

		BENEFITS ACCEPTED SOURCE: Royal Netherlands Army using NATO funds

		NEGATIVE REPORT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED SOURCE. : 

		TRAVEL DATES. : 

		LOCATION: 

		EVENT DATES. : 

		EVENT SPONSOR : 

		EVENT DESCRIPTION: 

		TRAVELER (TITLE). Line 1 of 5.: 

		TRAVELER (NAME). Line 1 of 5.: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED SOURCE: 

		TRAVEL DATES.: 

		LOCATION: 

		EVENT DATES. : 

		EVENT SPONSOR : 

		EVENT DESCRIPTION: 

		TRAVELER (TITLE). Line 3 of 5.: 

		TRAVELER (NAME). Line 2 of 5.: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED SOURCE: 

		TRAVEL DATES. : 

		LOCATION: 

		EVENT DATES.: 

		EVENT DESCRIPTION: 

		TRAVELER (NAME). Line 3 of 5.: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 
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		TRAVELER (TITLE). Line 4 of 4.: 

		TRAVELER (NAME). Line 4 of 4.: 

		BENEFITS ACCEPTED SOURCE: 

		NEGATIVE REPORT: X

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED SOURCE. : 

		TRAVEL DATES. : 

		LOCATION: 

		EVENT DATES. : 

		EVENT SPONSOR : 

		EVENT DESCRIPTION: 

		TRAVELER (TITLE). Line 1 of 5.: 

		TRAVELER (NAME). Line 1 of 5.: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED SOURCE: 

		TRAVEL DATES.: 

		LOCATION: 

		EVENT DATES. : 

		EVENT SPONSOR : 

		EVENT DESCRIPTION: 

		TRAVELER (TITLE). Line 3 of 5.: 

		TRAVELER (NAME). Line 2 of 5.: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED SOURCE: 

		TRAVEL DATES. : 

		LOCATION: 

		EVENT DATES.: 

		EVENT DESCRIPTION: 

		TRAVELER (NAME). Line 3 of 5.: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		TRAVEL DATES. : 

		LOCATION: 

		EVENT DATES. : 

		EVENT SPONSOR : 

		EVENT DESCRIPTION: 

		TRAVELER (TITLE). Line 4 of 5.: 

		TRAVELER (NAME). Line 4 of 5.: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED SOURCE: 

		TRAVEL DATES. : 

		LOCATION: 

		EVENT DATES. : 

		EVENT SPONSOR : 

		EVENT DESCRIPTION: 

		TRAVELER (TITLE).  Line 5 of 5.: 

		TRAVELER (NAME). Line 5 of 5.: 

		BENEFITS ACCEPTED SOURCE: 










Completing the OGE Form-1353


Saving the Workbook


-


-


-


Preparing Blank Report Forms for Each Sub-Agency  (if applicable)


-


-


-


Completing the General Information


Renaming the Spreadsheet Tabs


-


-


-


-


Ensure use of standardized acronyms where applicable.


Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.


Instructions for § 1353 Travel Report


Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  


If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).


The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  


Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  


Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).


Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls


Fill in the white-colored cells found below Page, Of Pages, and Year. 


Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.


Filling in Page, Of Pages and  Year


Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  


For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 







-


-


-


-


Filling in Travel Specific Information


Indicating a Negative Report
-


-


Submitting the Report to OGE


Printing Reports for Internal Agency Use and Record Keeping


In Excel 2007
-


-


-


-


-


In Excel 2003
-


-


Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."


Indicating 1353 Travel


Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.


If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.


For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.


Filling in Agency Name, Sub-Component Name, and Contact Information


Indicating Reporting Period


Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  


In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  


Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.


While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.


Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 


On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".


Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”


To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.


Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.







-


-


-


Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.


Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.


Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.







Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission


Semiannual Report of Payment Accepted







Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President







Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency


If your agency is not listed here or if you have questions about the standard acronym for your      







Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC


    







EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP







OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA


                 r agency, please contact OGE at 1353travel@oge.gov







PAGE OF PAGES YEAR


1 1 2018


Agency Contact: MAJ Alex Barnett  


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825


Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


                              


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


                           


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


                              


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


                           


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


                              


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


                           


BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


USARAF
United States Army Africa / Southern European Task Force


NEGATIVE 
REPORT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


x x


REPORTING 
PERIOD: 


OCTOBER 1, 
2017- MARCH 


31, 2018


REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 


30, 2018


3


LOCATION


TRAVEL DATE(S)


Asia Pacific Forum 
Pacific Rim Foundation 


2


EX


TRAVEL DATE(S)


LOCATION


LOCATION


TRAVEL DATE(S)


1


LOCATION


TRAVEL DATE(S)


alex.c.barnett.mil@mail.mil


TRAVELER 


No.


This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


BENEFIT SOURCE


BENEFIT SOURCE


BENEFIT SOURCE


BENEFIT SOURCE





		Instruction Sheet

		Agency Acronym

		ASC






Completing the OGE Form-1353


Saving the Workbook


-


-


-


Preparing Blank Report Forms for Each Sub-Agency  (if applicable)


-


-


-


Completing the General Information


Renaming the Spreadsheet Tabs


-


-


-


-


Instructions for § 1353 Travel Report


Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  


If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).


The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  


Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  


Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).


Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls


Fill in the white-colored cells found below Page, Of Pages, and Year. 


Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.


Filling in Page, Of Pages and  Year


Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  


For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 


Ensure use of standardized acronyms where applicable.


Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.







-


-


-


-


Filling in Travel Specific Information


Indicating a Negative Report
-


-


Submitting the Report to OGE


Printing Reports for Internal Agency Use and Record Keeping


In Excel 2007
-


-


-


-


-


In Excel 2003
-


-


To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.


Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.


While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.


Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 


On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".


Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”


Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  


In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  


Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.


Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."


Indicating 1353 Travel


Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.


If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.


For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.


Filling in Agency Name, Sub-Component Name, and Contact Information


Indicating Reporting Period







-


-


-


Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.


Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.


Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.







Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission
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Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President







Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency


If your agency is not listed here or if you have questions about the standard acronym for your      







Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC


    







EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP







OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA


                 r agency, please contact OGE at 1353travel@oge.gov







PAGE OF PAGES YEAR


1 1 2018


Agency Contact: Marie A. Joiner


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825


Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Ronald Black AAAA Mission Solutions 
Summit 4/23/2018 Nashville, TN Lodging X $680 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $316 


COL AAAA            4/28/2018 04/23/2018 - 
04/28/2018                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Sam Baker AAAA Mission Solutions 
Summit 4/23/2018 Nashville, TN Lodging X $680 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $316 


CW5 AAAA 4/28/2018 04/23/2018 - 
04/28/2018                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Scott Nutter AAAA Mission Solutions 
Summit 4/23/2018 Nashville, TN Lodging X $680 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $316 


CSM AAAA 4/28/2018 04/23/2018 - 
04/28/2018                            


BENEFIT SOURCE


AAAA


BENEFIT SOURCE


AAAA


BENEFIT SOURCE


AAAA


BENEFIT SOURCE


2


EX


TRAVEL DATE(S)


LOCATION


LOCATION


TRAVEL DATE(S)


1


LOCATION


TRAVEL DATE(S)


marie.a.joiner.civ@mail.mil


TRAVELER 


No.


This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


Asia Pacific Forum 
Pacific Rim Foundation 


3


LOCATION


TRAVEL DATE(S)


BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


US Army
US Army Forces Command


NEGATIVE 
REPORT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


X


REPORTING 
PERIOD: 


OCTOBER 1, 
2017- MARCH 


31, 2018


REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 


30, 2018
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		RENAME BLANK FORM






Completing the OGE Form-1353


Saving the Workbook


-


-


-


Preparing Blank Report Forms for Each Sub-Agency  (if applicable)


-


-


-


Completing the General Information


Renaming the Spreadsheet Tabs


-


-


-


-


Instructions for § 1353 Travel Report


Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  


If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).


The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  


Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  


Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).


Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls


Fill in the white-colored cells found below Page, Of Pages, and Year. 


Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.


Filling in Page, Of Pages and  Year


Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  


For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 


Ensure use of standardized acronyms where applicable.


Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.







-


-


-


-


Filling in Travel Specific Information


Indicating a Negative Report
-


-


Submitting the Report to OGE


Printing Reports for Internal Agency Use and Record Keeping


In Excel 2007
-


-


-


-


-


In Excel 2003
-


-


To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.


Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.


While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.


Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 


On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".


Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”


Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  


In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  


Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.


Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."


Indicating 1353 Travel


Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.


If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.


For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.


Filling in Agency Name, Sub-Component Name, and Contact Information


Indicating Reporting Period







-


-


-


Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.


Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.


Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.







Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission


Semiannual Report of Payment Accepted







Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President







Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency


If your agency is not listed here or if you have questions about the standard acronym for your      







Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC


    







EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP







OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA


                 r agency, please contact OGE at 1353travel@oge.gov







PAGE OF PAGES YEAR


1 1 2018


Agency Contact:
U.S. Army Central, 
Shaw AFB


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825


Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


LTG Michael X. Garrett 2018 GCC CHOD - Gulf 
Region Conference 4/17/2018 Saudi Arabia Hotel         X $2,040 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Laundry         X $53.53 


Commanding General CENTCOM 4/19/2018 4/17/2018  4/19/2018


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


                           


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


BENEFIT SOURCE


Kingdom of Saudi Arabia 
(KSA)


BENEFIT SOURCE


BENEFIT SOURCE


BENEFIT SOURCE


2


EX


TRAVEL DATE(S)


LOCATION


LOCATION


TRAVEL DATE(S)


1


LOCATION


TRAVEL DATE(S)


Mr. Derek Taylor, (803) 885-8897


TRAVELER 


No.


This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


Asia Pacific Forum 
Pacific Rim Foundation 


3


LOCATION


TRAVEL DATE(S)


BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


[REPLACE  WITH REPORTING AGENCY NAME]
Office of the Staff Judge Advocate NEGATIVE 


REPORT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


X


REPORTING 
PERIOD: 


OCTOBER 1, 
2017- MARCH 


31, 2018


REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 


30, 2018
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SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE Form Approval.: 0416-GSA-SA
PAGE OF PAGES


REPORTING DEPARTMENT OR AGENCY REPORTING PERIOD


OCTOBER 1 - MARCH 31 (Year) APRIL 1 - SEPTEMBER 10 (Year)
NEGATIVE REPORT


John Smith 
Secretary


Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific 
Forum.


Asia-Pacific Forum 
Pacific Rim Assoc.


Joyce Smith 
Spouse of Secretary


Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific 
Forum.


Asia-Pacific Forum 
Pacific Rim Assoc.


This report implements 31 U.S.C. 1353. It does not supersede other reports that may have to be filled when travel expenses are accepted under other authority.  For definition and policies, see 41 CFR part 304-1.


AUTHORIZED FOR LOCAL REPRODUCTION


EVENT BENEFITS ACCEPTED
SOURCE DESCRIPTION


TRAVELER 
(Name/Title) DESCRIPTION/SPONSOR/ DATES


LOCATION AND  
TRAVEL DATES


EX
A


M
PL


ES


San Francisco, CA 
8/11-13/93


San Francisco, CA 
8/11-13/93


CHECK IN-KIND AMOUNT


Hotel  
Air Transportation 
Meals


Air Transportation 
Meals


X


X


X 
 


X


X


$280 
825 
120


$825 
120


STANDARD FORM 326 (2-98) 
Prescribed by GSA/OGE (41 CFR 301-1)


LOCATION


DATES:


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE 


DESCRIPTION


SPONSOR DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES







EVENT
DESCRIPTION/SPONSOR/DATES


LOCATION AND  
TRAVEL DATES


BENEFITS ACCEPTED
SOURCE DESCRIPTION CHECK IN-KIND AMOUNT


LOCATION


DATES:


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE 


DESCRIPTION


SPONSOR DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


TRAVELER 
(Name/Title)


STANDARD FORM 326 (2-98) 
 





SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

Form Approval.: 0416-GSA-SA

PAGE

OF PAGES

REPORTING DEPARTMENT OR AGENCY

REPORTING PERIOD

OCTOBER 1 - MARCH 31 (Year)

APRIL 1 - SEPTEMBER 10 (Year)

NEGATIVE REPORT

John Smith Secretary

Conference on Asia-Pacific

Relations sponsored by Asia-Pacific

Forum.

Asia-Pacific Forum

Pacific Rim Assoc.

Joyce Smith Spouse of Secretary

Conference on Asia-Pacific

Relations sponsored by Asia-Pacific

Forum.

Asia-Pacific Forum

Pacific Rim Assoc.

This report implements 31 U.S.C. 1353. It does not supersede other reports that may have to be filled when travel expenses are accepted under other authority.  For definition and policies, see 41 CFR part 304-1.

AUTHORIZED FOR LOCAL REPRODUCTION

EVENT

BENEFITS ACCEPTED

SOURCE

DESCRIPTION

TRAVELER

(Name/Title)

DESCRIPTION/SPONSOR/ DATES

LOCATION AND  TRAVEL DATES

EXAMPLES

San Francisco, CA 8/11-13/93

San Francisco, CA

8/11-13/93

CHECK

IN-KIND

AMOUNT

Hotel  Air Transportation Meals

Air Transportation Meals

X

X

X  X

X

$280 825 120

$825 120

STANDARD FORM 326 (2-98)

Prescribed by GSA/OGE (41 CFR 301-1)

LOCATION

DATES:

NAME

TITLE

DESCRIPTION

SPONSOR

DATES:

LOCATION

DATES

NAME

TITLE 

DESCRIPTION

SPONSOR

DATES

NAME

TITLE

DESCRIPTION

SPONSOR

DATES:

LOCATION

DATES

NAME

TITLE
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		REPORTING DEPARTMENT OR AGENCY: USARNORTH, JBSA - Fort Sam Houston, TX
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		NEGATIVE REPORT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 3120.00000000

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 1

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: Hotel

		BENEFITS ACCEPTED SOURCE. : Dutch Armed Forces

		TRAVEL DATES. : 9/16 to 9/29/2018

		LOCATION: Soesterberg,Netherlands, 

		EVENT DATES. : 9/16 to 9/29/2018

		EVENT SPONSOR : Dutch Armed Forces

		EVENT DESCRIPTION: Joint Deployable Exploitation and Analysis Laboratory (JDEAL) Exercise

		TRAVELER (TITLE). Line 1 of 5.: Physical ScientistForensic Exploitation Directorate

		TRAVELER (NAME). Line 1 of 5.: Rachel Pace

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 1495.00000000

		BENEFITS ACCEPTED AMOUNT: 260.00000000

		BENEFITS ACCEPTED AMOUNT: 605.00000000

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 1

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 1

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 1

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: Course Fee

		BENEFITS ACCEPTED DESCRIPTION: Air Transportation

		BENEFITS ACCEPTED DESCRIPTION: Hotel

		BENEFITS ACCEPTED SOURCE: International Association of Computer Investigative Specialists (IACIS)

		TRAVEL DATES.: 04/20-05/05/18

		LOCATION: Orlando, Florida

		EVENT DATES. : 04/20-05/05/18

		EVENT SPONSOR : American Legion

		EVENT DESCRIPTION: International Association of Computer Investigative Specialists Mobile Devise Training

		TRAVELER (TITLE). Line 3 of 5.: U.S. Army Protective Services Battalion

		TRAVELER (NAME). Line 2 of 5.: Vincent Olman, Jr.

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 467.00000000

		BENEFITS ACCEPTED AMOUNT: 595.00000000

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 1

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 1

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: Air Transportation 

		BENEFITS ACCEPTED DESCRIPTION: Hotel

		BENEFITS ACCEPTED SOURCE: American Legion

		TRAVEL DATES. : 08/25-08/29/18

		LOCATION: Minneapolis, Minnesota

		EVENT DATES.: 08/25-08/29/18

		EVENT DESCRIPTION: Recipient of American Legion's Spirit of Service Award during Annual National Convention

		TRAVELER (NAME). Line 3 of 5.: SGT Drew Hunnicutt

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		TRAVEL DATES. : 

		LOCATION: 

		EVENT DATES. : 

		EVENT SPONSOR : 

		EVENT DESCRIPTION: 

		TRAVELER (TITLE). Line 4 of 5.: 

		TRAVELER (NAME). Line 4 of 5.: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED SOURCE: 

		TRAVEL DATES. : 

		LOCATION: 

		EVENT DATES. : 

		EVENT SPONSOR : 

		EVENT DESCRIPTION: 

		TRAVELER (TITLE).  Line 5 of 5.: 

		TRAVELER (NAME). Line 5 of 5.: 

		BENEFITS ACCEPTED SOURCE: 










Completing the OGE Form-1353


Saving the Workbook


-


-


-


Preparing Blank Report Forms for Each Sub-Agency  (if applicable)


-


-


-


Completing the General Information


Renaming the Spreadsheet Tabs


-


-


-


-


Ensure use of standardized acronyms where applicable.


Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.


Instructions for § 1353 Travel Report


Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  


If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).


The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  


Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  


Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).


Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls


Fill in the white-colored cells found below Page, Of Pages, and Year. 


Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.


Filling in Page, Of Pages and  Year


Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  


For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 







-


-


-


-


Filling in Travel Specific Information


Indicating a Negative Report
-


-


Submitting the Report to OGE


Printing Reports for Internal Agency Use and Record Keeping


In Excel 2007
-


-


-


-


-


In Excel 2003
-


-


Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."


Indicating 1353 Travel


Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.


If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.


For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.


Filling in Agency Name, Sub-Component Name, and Contact Information


Indicating Reporting Period


Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  


In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  


Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.


While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.


Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 


On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".


Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”


To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.


Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.







-


-


-


Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.


Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.


Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.







Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission


Semiannual Report of Payment Accepted







Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President







Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency


If your agency is not listed here or if you have questions about the standard acronym for your      







Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC


    







EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP







OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA


                 r agency, please contact OGE at 1353travel@oge.gov







PAGE OF PAGES YEAR


1 1 2018


Agency Contact: Ms. Carolyn G. Dade


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825


Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


                           


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


                              


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


                           


BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


[REPLACE  WITH REPORTING AGENCY NAME]
U.S. Army Cyber Command NEGATIVE 


REPORT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


X X


REPORTING 
PERIOD: 


OCTOBER 1, 
2017- MARCH 


31, 2018


REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 


30, 2018


3


LOCATION


TRAVEL DATE(S)


Asia Pacific Forum 
Pacific Rim Foundation 


2


EX


TRAVEL DATE(S)


LOCATION


LOCATION


TRAVEL DATE(S)


1


LOCATION


TRAVEL DATE(S)


carolyn.g.dade.civ@mail.mil


TRAVELER 


No.


This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


BENEFIT SOURCE


BENEFIT SOURCE


BENEFIT SOURCE


BENEFIT SOURCE





		Instruction Sheet

		Agency Acronym

		RENAME BLANK FORM






SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE Form Approval.: 0416-GSA-SA
PAGE OF PAGES


REPORTING DEPARTMENT OR AGENCY REPORTING PERIOD


OCTOBER 1 - MARCH 31 (Year) APRIL 1 - SEPTEMBER 10 (Year)
NEGATIVE REPORT


John Smith 
Secretary


Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific 
Forum.


Asia-Pacific Forum 
Pacific Rim Assoc.


Joyce Smith 
Spouse of Secretary


Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific 
Forum.


Asia-Pacific Forum 
Pacific Rim Assoc.


This report implements 31 U.S.C. 1353. It does not supersede other reports that may have to be filled when travel expenses are accepted under other authority.  For definition and policies, see 41 CFR part 304-1.


AUTHORIZED FOR LOCAL REPRODUCTION


EVENT BENEFITS ACCEPTED
SOURCE DESCRIPTION


TRAVELER 
(Name/Title) DESCRIPTION/SPONSOR/ DATES


LOCATION AND  
TRAVEL DATES


EX
A


M
PL


ES


San Francisco, CA 
8/11-13/93


San Francisco, CA 
8/11-13/93


CHECK IN-KIND AMOUNT


Hotel  
Air Transportation 
Meals


Air Transportation 
Meals


X


X


X 
 


X


X


$280 
825 
120


$825 
120


STANDARD FORM 326 (2-98) 
Prescribed by GSA/OGE (41 CFR 301-1)


LOCATION


DATES:


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE 


DESCRIPTION


SPONSOR DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


12th Combat Aviation Brigade 2018


1 1


16.00


206.50


2,763.84


369.20


Misc.


Meals


Transportation


Lodging


Army Aviation 
Association of America 
 
 


25 - 28 April 2018


Nashville, TN


25 - 27 April 2018


Army Aviation Association of 
America


2018 Army Aviation Mission 
Solutions Summit


Commander 


 
COL Kenneth Cole 


206.50


2,646.70


369.20


Misc.


Meals


Transportation


Lodging


Army Aviation 
Association of America 
 
 


25 - 28 April 2018


Nashville, TN


25 - 27 April 2018


Army Aviation Association of 
America


2018 Army Aviation Mission 
Solutions Summit


Chief Warrant Officer 


CW5 Eugene Santos 


3.00


206.50


2,646.70


369.20


Misc. 


Meals


Transportation


Lodging


25 - 28 April 2018


 
 
Nashville, TN


25 - 27 April 2018


American Aviation Association of 
America


 
2018 Army Aviation Mission 
Solutions Summit


Command Sergeant Major 


CSM Mark Smith 


  


 


Army Aviation 
Association of America 
 
 







EVENT
DESCRIPTION/SPONSOR/DATES


LOCATION AND  
TRAVEL DATES


BENEFITS ACCEPTED
SOURCE DESCRIPTION CHECK IN-KIND AMOUNT


LOCATION


DATES:


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE 


DESCRIPTION


SPONSOR DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


TRAVELER 
(Name/Title)


STANDARD FORM 326 (2-98) 
 


 
 
  


 


 
 
  


 


 
 
  


 
 


 


 


 
 
  


 


 
 
 







SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE Form Approval.: 0416-GSA-SA
PAGE OF PAGES


REPORTING DEPARTMENT OR AGENCY REPORTING PERIOD


OCTOBER 1 - MARCH 31 (Year) APRIL 1 - SEPTEMBER 30 (Year)
NEGATIVE REPORT


John Smith 
Secretary


Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific 
Forum.


Asia-Pacific Forum 
Pacific Rim Assoc.


Joyce Smith 
Spouse of Secretary


Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific 
Forum.


Asia-Pacific Forum 
Pacific Rim Assoc.


This report implements 31 U.S.C. 1353. It does not supersede other reports that may have to be filled when travel expenses are accepted under other authority.  For definition and policies, see 41 CFR part 304-1.


AUTHORIZED FOR LOCAL REPRODUCTION


EVENT BENEFITS ACCEPTED
SOURCE DESCRIPTION


TRAVELER 
(Name/Title) DESCRIPTION/SPONSOR/ DATES


LOCATION AND  
TRAVEL DATES


EX
A


M
PL


ES


San Francisco, CA 
8/11-13/93


San Francisco, CA 
8/11-13/93


CHECK IN-KIND AMOUNT


Hotel  
Air Transportation 
Meals


Air Transportation 
Meals


X


X


X 
 


X


X


$280 
825 
120


$825 
120


STANDARD FORM 326 (2-98) 
Prescribed by GSA/OGE (41 CFR 301-1)


LOCATION


DATES:


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE 


DESCRIPTION


SPONSOR DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


220.00


 


Lodging 


Austrian Armed Forces 17-19 SEP 18


Graz, Austria


17-19 September 2018
Austrian Armed Forces 


Commanders of European Land 
Forces Conference


USAREUR Commanding General 


LTG Christopher Cavoli 


3,212.60


 


 


 Registration Fee


Development Network 
(TDNUK) and Combat 
Logistics 17-19 APR 18


Warsaw, Poland


17-19 April 2018 


Development Network (TDNUK) 
and Combat Logistics  


The Combat Logistics 2018 
Conference


USAREUR ACoSM G4


COL Robert Dixon 


3,212.60


 


 Registration Fee


17-19 APR 18


 
Warsaw, Poland 


17-19 April 2018 


Development Network (TDNUK) 
and Combat Logistics 


 
The Combat Logistics 2018 
Conference


USAREUR G3 SGM


SGM James Herrington 


206.50


2,763.84


369.20


Meals


Transportation


Lodging


AAAA25 - 28 April 2018


Nashville, TN


25-28 APR 18


Army Aviation Association of 
America (AAAA)


 
2018 Army Aviation Mission 
Solutions Summit


Chief, G3 Aviation 


COL Robert Keeter


Development Network 
(TDNUK) and Combat 
Logistics 







EVENT
DESCRIPTION/SPONSOR/DATES


LOCATION AND  
TRAVEL DATES


BENEFITS ACCEPTED
SOURCE DESCRIPTION CHECK IN-KIND AMOUNT


LOCATION


DATES:


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE 


DESCRIPTION


SPONSOR DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


TRAVELER 
(Name/Title)


STANDARD FORM 326 (2-98) 
 


38,500.00Lodging British Army housed 
USAREUR Band in local 
military barracks for 
event. Costs were 
calculated using London 
lodging per diem rate for 
25 travelers over 5 days 4-9 JUN 18


London, England


4-9 June 2018


Household Division's  
Beating Retreat Event 


25 Personnel 


USAREUR Band
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Completing the OGE Form-1353


Saving the Workbook


-


-


-


Preparing Blank Report Forms for Each Sub-Agency  (if applicable)


-


-


-


Completing the General Information


Renaming the Spreadsheet Tabs


-


-


-


-


Instructions for § 1353 Travel Report


Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  


If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).


The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  


Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  


Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).


Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls


Fill in the white-colored cells found below Page, Of Pages, and Year. 


Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.


Filling in Page, Of Pages and  Year


Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  


For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 


Ensure use of standardized acronyms where applicable.


Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.







-


-


-


-


Filling in Travel Specific Information


Indicating a Negative Report
-


-


Submitting the Report to OGE


Printing Reports for Internal Agency Use and Record Keeping


In Excel 2007
-


-


-


-


-


In Excel 2003
-


-


To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.


Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.


While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.


Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 


On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".


Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”


Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  


In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  


Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.


Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."


Indicating 1353 Travel


Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.


If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.


For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.


Filling in Agency Name, Sub-Component Name, and Contact Information


Indicating Reporting Period







-


-


-


Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.


Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.


Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.







Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission


Semiannual Report of Payment Accepted







Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President







Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency


If your agency is not listed here or if you have questions about the standard acronym for your      







Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC


    







EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP







OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA


                 r agency, please contact OGE at 1353travel@oge.gov







PAGE OF PAGES YEAR


2018


Agency Contact:
[Replace with 
Agency Contact 
Name]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825


Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Jennifer Bower


Education and 
Communications 
Strategies 
Conference/Seminar


8/1/2018 State College, PA                               


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Transportation X


LTC
Pennsylvania Training and 
Technical Assistance 
Network


8/3/2018 08/1/2018-08/3/2018                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


N/A


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]


Strategic Studies Center


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Marybeth Ulrich Visting Lecturer at Baltic 
Defense College 5/2/2018 Estonia Transportation X 1000


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging X 700


PhD The Baltic Defence 
College 5/8/2018 5/1/2018-5/09/2018 Meals X 75


BENEFIT SOURCE


Pennsylvania Training 
and Technical Assistance 


Network


BENEFIT SOURCE


BENEFIT SOURCE


The Baltic Defence 
College


BENEFIT SOURCE


2


EX


TRAVEL DATE(S)


LOCATION


LOCATION


TRAVEL DATE(S)


1


LOCATION


TRAVEL DATE(S)


[Replace with Agency Contact 
Email]


TRAVELER 


No.


This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


Asia Pacific Forum 
Pacific Rim Foundation 


3


LOCATION


TRAVEL DATE(S)


BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


[REPLACE  WITH REPORTING AGENCY NAME]
[REPLACE WITH SUB-AGENCY NAME] NEGATIVE 


REPORT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


X


REPORTING 
PERIOD: 


OCTOBER 1, 
2017- MARCH 


31, 2018


REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 


30, 2018





		Instruction Sheet

		Agency Acronym

		RENAME BLANK FORM






Human Resources Command, Fort Knox, KY X  2018


1 24







2


x   2018HUMAN RESOURCES COMMAND, FORT KNOX, KY


24







X   2018


3 24







X


4 24







XX5


XXXXXXX 2018X


XX 24


2018 2018







6


X   2018


2018 2018


24







XX  24X


XXXXXX X   2018


7


09-13 APRIL 2018







X    2018


X 8 XX  24


1 mAR - 6 jUL 2018







X    2018


9


2018 2018


24







X   2018


10- 24







X   2018


11 24







25-27 APRIL 2018


2018


12 24







X


3         XX  24







X   2018


14 24







2018 2018


X   2018


15 24







XXXXXX X XXXXX


6         XX  24







2018 2018


XXXXXXX XXXXXX


7          X  24







X   2018


8          X  24







X   2018


9          X  24







X   2018


20 X            X  24







X


2              X  24







X


22 X            X  24







X  23 X  24







X   2018


24          24












SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE Form Approval.: 0416-GSA-SA
PAGE OF PAGES


REPORTING DEPARTMENT OR AGENCY REPORTING PERIOD


OCTOBER 1 - MARCH 31 (Year) APRIL 1 - SEPTEMBER 10 (Year)
NEGATIVE REPORT


John Smith 
Secretary


Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific 
Forum.


Asia-Pacific Forum 
Pacific Rim Assoc.


Joyce Smith 
Spouse of Secretary


Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific 
Forum.


Asia-Pacific Forum 
Pacific Rim Assoc.


This report implements 31 U.S.C. 1353. It does not supersede other reports that may have to be filled when travel expenses are accepted under other authority.  For definition and policies, see 41 CFR part 304-1.


AUTHORIZED FOR LOCAL REPRODUCTION


EVENT BENEFITS ACCEPTED
SOURCE DESCRIPTION


TRAVELER 
(Name/Title) DESCRIPTION/SPONSOR/ DATES


LOCATION AND  
TRAVEL DATES


EX
A


M
PL


ES


San Francisco, CA 
8/11-13/93


San Francisco, CA 
8/11-13/93


CHECK IN-KIND AMOUNT


Hotel  
Air Transportation 
Meals


Air Transportation 
Meals


X


X


X 
 


X


X


$280 
825 
120


$825 
120


STANDARD FORM 326 (2-98) 
Prescribed by GSA/OGE (41 CFR 301-1)


LOCATION


DATES:


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE 


DESCRIPTION


SPONSOR DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES







EVENT
DESCRIPTION/SPONSOR/DATES


LOCATION AND  
TRAVEL DATES


BENEFITS ACCEPTED
SOURCE DESCRIPTION CHECK IN-KIND AMOUNT


LOCATION


DATES:


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE 


DESCRIPTION


SPONSOR DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


TRAVELER 
(Name/Title)


STANDARD FORM 326 (2-98) 
 





SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

Form Approval.: 0416-GSA-SA

PAGE

OF PAGES

REPORTING DEPARTMENT OR AGENCY

REPORTING PERIOD

OCTOBER 1 - MARCH 31 (Year)

APRIL 1 - SEPTEMBER 10 (Year)

NEGATIVE REPORT

John Smith Secretary

Conference on Asia-Pacific

Relations sponsored by Asia-Pacific

Forum.

Asia-Pacific Forum

Pacific Rim Assoc.

Joyce Smith Spouse of Secretary

Conference on Asia-Pacific

Relations sponsored by Asia-Pacific

Forum.

Asia-Pacific Forum

Pacific Rim Assoc.

This report implements 31 U.S.C. 1353. It does not supersede other reports that may have to be filled when travel expenses are accepted under other authority.  For definition and policies, see 41 CFR part 304-1.

AUTHORIZED FOR LOCAL REPRODUCTION

EVENT

BENEFITS ACCEPTED

SOURCE

DESCRIPTION

TRAVELER

(Name/Title)

DESCRIPTION/SPONSOR/ DATES

LOCATION AND  TRAVEL DATES

EXAMPLES

San Francisco, CA 8/11-13/93

San Francisco, CA

8/11-13/93

CHECK

IN-KIND

AMOUNT

Hotel  Air Transportation Meals

Air Transportation Meals

X

X

X  X

X

$280 825 120

$825 120

STANDARD FORM 326 (2-98)

Prescribed by GSA/OGE (41 CFR 301-1)

LOCATION

DATES:

NAME

TITLE

DESCRIPTION

SPONSOR

DATES:

LOCATION

DATES

NAME

TITLE 

DESCRIPTION

SPONSOR

DATES

NAME

TITLE

DESCRIPTION

SPONSOR

DATES:

LOCATION

DATES

NAME

TITLE

DESCRIPTION

SPONSOR

DATES:

LOCATION

DATES

EVENT

DESCRIPTION/SPONSOR/DATES

LOCATION AND 

TRAVEL DATES

BENEFITS ACCEPTED

SOURCE

DESCRIPTION

CHECK

IN-KIND

AMOUNT

LOCATION

DATES:

NAME

TITLE

DESCRIPTION

SPONSOR

DATES:

LOCATION

DATES

NAME

TITLE

DESCRIPTION

SPONSOR

DATES:

LOCATION

DATES

NAME

TITLE 

DESCRIPTION

SPONSOR

DATES

NAME

TITLE

DESCRIPTION

SPONSOR

DATES:

LOCATION

DATES

NAME

TITLE

DESCRIPTION

SPONSOR

DATES:

LOCATION

DATES

TRAVELER

(Name/Title)

STANDARD FORM 326 (2-98)

 

		REPORTING DEPARTMENT OR AGENCY: US Army Installation Management Command

		REPORTING PERIOD. OCTOBER 1- MARCH 31 (YEAR): 

		REPORTING PERIOD. APRIL - SEPTEMBER 10 (YEAR): XX                         2018

		PAGE: 1

		OF PAGES: 8

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 2130.00000000

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 1

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: Hotel/Meals

		BENEFITS ACCEPTED SOURCE: USA Rugby

		TRAVEL DATES. : 3/24-4/16/2018

		LOCATION: Chula Vista, CA

		EVENT DATES. : 3/24-4/16/2018

		EVENT SPONSOR : USA Rugby

		EVENT DESCRIPTION: Women's National Sevens Base Camp

		TRAVELER (TITLE).  Line 1 of 4.: Soldier AthleteArmy World Class Athlete Program

		TRAVELER (NAME).  Line 1 of 4.: 1LT Kasey McCravey

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 825.00000000

		BENEFITS ACCEPTED AMOUNT: 450.00000000

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 1

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 1

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: Air Transportation

		BENEFITS ACCEPTED DESCRIPTION: Hotel/Meals

		BENEFITS ACCEPTED SOURCE: U.S. Olympic Committee

		TRAVEL DATES. : 4/3-9/2018

		LOCATION: Montreal, Canada

		EVENT DATES. : 4/3-9/2018

		EVENT SPONSOR : U.S. Olympic Committee

		EVENT DESCRIPTION: 2018 CanAm/Canadian National Championships

		TRAVELER (TITLE). Line 2 of 4.: Soldier AthleteArmy World Class Athlete Program

		TRAVELER (NAME). Line 2 of 4.: SSG Elizabeth Marks

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 500.00000000

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 1

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: Hotel

		TRAVEL DATES. : 4/6-7/2018

		LOCATION: Washington, DC

		EVENT DATES.: 4/6-7/2018

		EVENT SPONSOR : Credit Union Cherry Blossom Ten Mile 

		EVENT DESCRIPTION: 2018 Credit Union Cherry Blossom Ten Mile 

		TRAVELER (TITLE). Line 3 of 4.: Soldier AthleteArmy World Class Athlete Program

		TRAVELER (NAME). Line 3 of 4.: SPC Susan Tanui

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 600.00000000

		BENEFITS ACCEPTED AMOUNT: 800.00000000

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 1

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 1

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: Air Transportation

		BENEFITS ACCEPTED DESCRIPTION: Hotel/Meals

		BENEFITS ACCEPTED SOURCE: U.S. Soccer Federation

		TRAVEL DATES. : 4/8-13/2018

		LOCATION: Lakewood Ranch, FL

		EVENT DATES. : 4/8-13/2018

		EVENT SPONSOR : U.S. Soccer Federation

		EVENT DESCRIPTION: Domestic Training Camp

		TRAVELER (TITLE). Line 4 of 4.: Soldier AthleteArmy World Class Athlete Program

		TRAVELER (NAME). Line 4 of 4.: 1LT David Garza

		BENEFITS ACCEPTED SOURCE: Credit Union Cherry Blossom Ten Mile 

		NEGATIVE REPORT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 450.00000000

		BENEFITS ACCEPTED AMOUNT: 1200.00000000

		BENEFITS ACCEPTED AMOUNT: 1125.00000000

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 1

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 1

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 1

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: Meals

		BENEFITS ACCEPTED DESCRIPTION: Air Transportation

		BENEFITS ACCEPTED DESCRIPTION: Hotel

		BENEFITS ACCEPTED SOURCE. : USA Shooting

		TRAVEL DATES. : 4/18-27/2018

		LOCATION: Changwong, ROK

		EVENT DATES. : 4/18-27/2018

		EVENT SPONSOR : USA Shooting

		EVENT DESCRIPTION: 2018 World Cup Korea

		TRAVELER (TITLE). Line 1 of 5.: Soldier AthleteArmy World Class Athlete Program

		TRAVELER (NAME). Line 1 of 5.: SGT Nickolaus Mowrer

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 1500.00000000

		BENEFITS ACCEPTED AMOUNT: 3000.00000000

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 1

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 1

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: Air Transportation

		BENEFITS ACCEPTED DESCRIPTION: Hotel/Meals

		BENEFITS ACCEPTED SOURCE: USA Rugby

		TRAVEL DATES.: 4/20-30/2018

		LOCATION: Kallang, Singapore

		EVENT DATES. : 4/20-30/2018

		EVENT SPONSOR : USA Bobsled & Skeleton

		EVENT DESCRIPTION: World Rugby Sevens World Series

		TRAVELER (TITLE). Line 3 of 5.: Soldier AthleteArmy World Class Athlete Program

		TRAVELER (NAME). Line 2 of 5.: SPC Cody Melphy

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 600.00000000

		BENEFITS ACCEPTED AMOUNT: 520.00000000

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 1

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 1

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: Air Transportation

		BENEFITS ACCEPTED DESCRIPTION: Hotel/Meals

		BENEFITS ACCEPTED SOURCE: USA Bobsled & Skeleton

		TRAVEL DATES. : 4/24-27/2018

		LOCATION: Washington, DC

		EVENT DATES.: 4/24-27/2018

		EVENT DESCRIPTION: 2018 Olympic Team White House Visit

		TRAVELER (NAME). Line 3 of 5.: CPT Christopher Fogt

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 600.00000000

		BENEFITS ACCEPTED AMOUNT: 520.00000000

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 1

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 1

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: Air Transportation

		BENEFITS ACCEPTED DESCRIPTION: Hotel/Meals

		TRAVEL DATES. : 4/24-27/2018

		LOCATION: Washington, DC

		EVENT DATES. : 4/24-27/2018

		EVENT SPONSOR : USA Luge

		EVENT DESCRIPTION: 2018 Olympic Team White House Visit

		TRAVELER (TITLE). Line 4 of 5.: Soldier AthleteArmy World Class Athlete Program

		TRAVELER (NAME). Line 4 of 5.: SGT Taylor Morris

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 600.00000000

		BENEFITS ACCEPTED AMOUNT: 520.00000000

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 1

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 1

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: Air Transportation

		BENEFITS ACCEPTED DESCRIPTION: Hotel/Meals

		BENEFITS ACCEPTED SOURCE: USA Bobsled & Skeleton

		TRAVEL DATES. : 4/24-27/2018

		LOCATION: Washington, DC

		EVENT DATES. : 4/24-27/2018

		EVENT SPONSOR : USA Bobsled & Skeleton

		EVENT DESCRIPTION: 2018 Olympic Team White House Visit

		TRAVELER (TITLE).  Line 5 of 5.: Soldier AthleteArmy World Class Athlete Program

		TRAVELER (NAME). Line 5 of 5.: SGT Nicholas Cunningham

		BENEFITS ACCEPTED SOURCE: USA Luge
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8.2.1.4029.1.523496.503679

		REPORTING DEPARTMENT OR AGENCY: US Army Installation Management Command

		EVENT DATES:: 5/3-7/2018

		BENEFITS ACCEPTED. AMOUNT: 400.00000000

		TRAVELER NAME. CONTINUED FROM FIRST PAGE. SECTION 6 OF 10: SPC Leonard Korir

		TRAVELER TITLE: Soldier AthleteArmy World Class Athlete Program

		EVENT DESCRIPTION: 2018 U.S. Half Marathon Championship

		LOCATION: Pittsburgh, PA

		TRAVEL DATES: 5/3-7/2018

		BENEFITS ACCEPTED. SOURCE: Pittsburgh Three Rivers Marathon, Inc.

		BENEFITS ACCEPTED. DESCRIPTION. LINE 3 OF 4: Meals

		BENEFITS ACCEPTED. CHECK: 

		BENEFITS ACCEPTED. IN-KIND: X

		EVENT SPONSOR: Pittsburgh Three Rivers Marathon,Inc.
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8.2.1.4029.1.523496.503679

		REPORTING DEPARTMENT OR AGENCY: US Army Installation Management Command

		EVENT DATES:: 5/25-26/2018

		BENEFITS ACCEPTED. AMOUNT: 761.00000000

		TRAVELER NAME. CONTINUED FROM FIRST PAGE. SECTION 6 OF 10: SSG Emmanuel Bor

		TRAVELER TITLE: Soldier AthleteArmy World Class Athlete Program

		EVENT DESCRIPTION: 2018 Prefontaine Classic

		LOCATION: Eugene, OR

		TRAVEL DATES: 5/25-26/2018

		BENEFITS ACCEPTED. SOURCE: IAAF Diamond League

		BENEFITS ACCEPTED. DESCRIPTION. LINE 3 OF 4: Air Transportation

		BENEFITS ACCEPTED. CHECK: 

		BENEFITS ACCEPTED. IN-KIND: X

		EVENT SPONSOR: IAAF Diamond League
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8.2.1.4029.1.523496.503679

		REPORTING DEPARTMENT OR AGENCY: US Army Installation Management Command

		EVENT DATES:: 7/2-5/2018

		BENEFITS ACCEPTED. AMOUNT: 500.00000000

		TRAVELER NAME. CONTINUED FROM FIRST PAGE. SECTION 6 OF 10: SGT Augutus Maiyo

		TRAVELER TITLE: Soldier AthleteArmy World Class Athlete Program

		EVENT DESCRIPTION: 2018 AJC Peachtree Road Race

		LOCATION: Atlanta, GA

		TRAVEL DATES: 7/2-5/2018

		BENEFITS ACCEPTED. SOURCE: Atlanta Track Club, Inc.

		BENEFITS ACCEPTED. DESCRIPTION. LINE 3 OF 4: Meals

		BENEFITS ACCEPTED. CHECK: 

		BENEFITS ACCEPTED. IN-KIND: X

		EVENT SPONSOR: Atlanta Track Club, Inc.
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8.2.1.4029.1.523496.503679

		REPORTING DEPARTMENT OR AGENCY: US Army Installation Management Command

		EVENT DATES:: 8/5-11/2018

		BENEFITS ACCEPTED. AMOUNT: 200.00000000

		TRAVELER NAME. CONTINUED FROM FIRST PAGE. SECTION 6 OF 10: 1LT Daniel Zeck

		TRAVELER TITLE: Soldier AthleteArmy World Class Athlete Program

		EVENT DESCRIPTION: USA Team Handball TrainingCamp

		LOCATION: Dormagen, Germany

		TRAVEL DATES: 8/2-11/2018

		BENEFITS ACCEPTED. SOURCE: USA Team Handball

		BENEFITS ACCEPTED. DESCRIPTION. LINE 3 OF 4: Meals

		BENEFITS ACCEPTED. CHECK: 

		BENEFITS ACCEPTED. IN-KIND: X

		EVENT SPONSOR: USA Team Handball
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